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4.36.75 Configure the Operator groups access rights 

This field allows the selection of a type of confirmation via a drop down list, needed to accept only changes to their 
own configured operator group configurations in the ‘InTouch WindowViewer’. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 

4.36.76 Configure the Override Server Redundancy access rights 

This field allows the selection of a type of confirmation via a drop down list, needed before switching from a server that 
has detected the ‘LINOPC’ watchdog has ceased to a second specified server in the ‘InTouch WindowViewer’. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 
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4.36.77 Configure the Password Expiry field 

This field allows the input of a specified period in days until a User password will expire for the selected Security item 
type. 

Note 
The default value limits of the field are subject to Regulatory defaults. 

The Password expiry period is configured in the databases for the Security Manager, 5000 Series and Visual Supervisor 
instruments Security items. 

Note 
The Password expiry period does NOT apply to passwords received via Security deployment. 

To configure this 

1. Click the Password expiry field. 

Note 
If the value is NOT highlighted double click in the field. 

 

2. At the keyboard, enter a new value and press the return key. 

Note 
If a value outside the constraints is entered, a dialog window appears Read the dialog and click ‘Ok’ to return this field to 

its previous setting. 

 

3. Finally, save changes and proceed to the next task. 

4.36.78 Configure the Paste/Delete Files access rights 

This check box allows or does not allow the Users assigned to the selected User group to copy, paste and delete 
specified configurations. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to copy, paste and 
delete specified configurations. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Paste/Delete Files check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.79 Configure the Perform Upgrade access rights 

This field allows or does not allow the User to perform an update to the instrument software. 
This is configured in the database for the 6000 Series instrument Security item. 

To configure this 

1. Click the Perform Update checkbox. 

 indicates the User can update the instrument software. 

 indicates the User is not permitted to update the instrument software. 

2. Finally, save changes and proceed to the next task. 

4.36.80 Configure the Preset Counters access rights 

This check box allows or does not allow the Users assigned to the selected User group to preset counter values (if the 
option is fitted) either directly from the configuration page or by setting a counter job. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to preset counter 
values, if the option is fitted. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Preset Counters check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.81 Configure the Preset Totalisers access rights 

This check box allows or does not allow the Users assigned to the selected User group to preset totaliser values (if the 
option is fitted) either directly from the configuration page or by setting a totaliser job. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to preset totaliser 
values, if the option is fitted. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Preset Totalisers check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.82 Configure the Print Setup access rights 

This check box allows or does not allow the Users to configure the print parameters, excluding Print Range that must be 
enabled in Modify Chart View. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to use the Print Setup 
command. If False, the User group has been denied the access rights. 
This is configured in the database for the Review and QuickChart software item type. 

To configure this 

1. Click the Print Setup check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.83 Configure the Print access rights 

This check box allows or does not allow the Users assigned to the selected User group to print selected pages from the 
‘InTouch WindowViewer’ or charts and spreadsheets from Review software. 

Note 
Review software requires that to modify the Print Range in the print setup dialog the Modify Chart View must be enabled. 

Print Setup must be enabled to modify other print data. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to print. If False, the 
User group has been denied the access rights. 
This is configured in the database for EurothermSuite PC, Review and QuickChart software Security item types. 

To configure this 

1. Click the Print check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.84 Configure the Recipe Download access rights 

This field allows the selection of a type of confirmation via a drop down list, needed before a recipe can be downloaded 
to a specified location. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 



SECURITY MANAGER (VERSION 1.8) USER GUIDE 

Page 104 HA028131 

 Issue 5  Aug 09 

4.36.85 Configure the Record Logins field 

This check box allows or does not allow the Users assigned to the selected User group to any future login or logout 
message appearing on the chart only when the Default Regulation is selected 
Options > Regulations 
The other Regulations are pre-configured to record this information in the Audit Trail. 

Note 
The default value limits of the field are subject to Regulatory defaults. 

It has 2 states, - True or - False. If the check box is set to (True - 21 CFR Part 11 compliant), any login or logout 
message will occur on the chart. It will include the date, time, MAC address of the remote viewing device and login 
name. If False, the Audit Trail will NOT log any events in the selected zone. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Record Logins check box. indicates the feature is enabled in this Security item type. indicates it is 
disabled. 

 

2. Finally, save changes and proceed to the next task. 

4.36.86 Configure the Recovery account field 

This check box allows or does NOT allow the Users assigned to the selected User group to enable or disable the Visual 
Supervisor Recovery account feature. 

It is recommended that this field is set to True, to ensure it is always possible to retrieve a corrupt database. 

It has 2 states, - True or - False. If the field is set to True a User can access a Visual Supervisor item type that has 
ALL Users ‘Locked out’, ‘Disabled’ or ‘Retired’ using a blank User Id. The User will login with full access rights. If the 
field is set to False, the ‘Recovery account’ is disabled. 

Note 
If this feature has NOT been enabled, the instrument must be returned to the supplier where recovery of the account can 

be attempted. 

This is configured in the database for Visual Supervisor Security item type. 

To configure this 

1. Click the Recovery account check box. 

 indicates that the User may shutdown the Export Historical Trend view in the Visual Supervisor item type. 

 indicates the Users has insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.87 Configure the Recovery user field 

This check box allows or does not allow the Users to enable or disable the ‘Recovery user ’ account. 

It has 2 states, - True or - False. If the field is set to True a User can access the database that has ALL Users 
‘Locked out’, ‘Disabled’ or ‘Retired’ using a blank User Id. The User can login with full Access Rights. If the field is set to 
False, the Recovery user account is disabled. 
This is configured in the database for the Security Manager. 

To configure this 

1. Click the Recovery user check box. 

 indicates that the Recovery user is configured in the Computer Security item type. 

 indicates it is NOT configured. 

 

2. Finally, save changes and proceed to the next task. 

4.36.88 configure the Reference Number access rights 

This field allows the User to enter a Reference Number between ‘0’ and ‘65535’ that corresponds to a number entered 
in software scripts used within a Visual Supervisor. 
As the Reference Number within Security Manager is configured per User group, ALL Users within that User group 
inherit the specified Reference Number. Therefore, a User assigned to numerous User groups may have numerous 
reference numbers corresponding to areas within Visual Supervisor software scripts. 

Note 
If a User is assigned to numerous User groups only the Users highest ‘Reference Number’ is deployed, ignoring all the 

Users other reference numbers that may cause the software scripts to operate incorrectly. 

It is recommended that to avoid problems when using the ‘Reference Number’ field, each User should also have their 
own individual User group with only the ‘Reference Number’ configured. 

This is configured in the database for Visual Supervisor Security item types. 

To configure this 

1. Click the Reference Number field. 

Note 
If the value is not highlighted double click in the field. 

 

2. At the keyboard, enter a new value and press the return key. 

Note 
If a value outside the constraints is entered, a dialog window appears Read the dialog and click ‘Ok’ to return this field to 

its previous setting. 

 

3. Finally, save changes and proceed to the next task. 
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4.36.89 Configure the Remote access rights 

This field allows or does not allow Users remote access to this Security item type, in this Security zone. 
This is configured in the database for Visual Supervisor Security items. 

To configure this 

1. Click the Remote checkbox. 

 indicates the User can remotely access this Security item type, in this Security zone. 

 indicates the User is not permitted to remotely access this Security item type, in this Security zone. 

2. Finally, save changes and proceed to the next task. 

4.36.90 Configure the Reset Maths access rights 

This check box allows or does not allow the Users assigned to the selected User group to reset applicable maths 
function, 
from the maths channel configuration page 
by setting a maths job 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to reset applicable 
maths function. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Reset Maths check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.91 Configure the Save Chart access rights 

This check box allows or does not allow the Users to save the new view of a file that has been modified by one of the 
actions allowed in Modify Chart View. 

Note 
This command is automatically enabled if Chart Setup access right is True. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to save the new view of 
a file. If False, the User group has been denied the access rights. 
This is configured in the database for the Review and QuickChart software item type. 

To configure this 

1. Click the Save Chart check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.92 Configure the Save/Restore access rights 

This check box allows or does not allow the Users assigned to the selected User group to saving or restoring 5000 Series 
configurations. User Screens can be imported and exported if the User Screens option is fitted. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to save or restore a 
configuration. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Save/Restore check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.93 Configure the Set Clock access rights 

This check box allows or does not allow the Users assigned to the selected User group to set the time and date 
functions. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to set the time and date 
functions. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Set Clock check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.94 Configure the Sign access rights 

This check box check box allows or does not allow the Users to sign for unsaved changes at the Security item type in 
the Security zone. 

Note 

If Sign is configured as False a User will still be requested to Sign for unsaved changes IF the Authorise field is configured 
as True. 

Note 
The 5000 Series Instruments also use the Sign feature, but is referred to as ‘Can Sign’. 

It has 2 states, - True or - False. If the check box is set to True the User is allowed to sign. If False, the User 
group has been denied the access rights. 

This is configured in the database for Security Manager, EurothermSuite PC, / Eycon™10/20 Visual Supervisor, 5000 and 
6000 Series recorder Security item types. 

To configure this 

1. Click the Sign check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.95 Configure the Signing field 

This check box allows or does not allow the Users assigned to the selected User group to request a Authentication 
Signature for the selected Security item type when the Default or 21 CFR Part 11 - Records Regulation is selected via 
Options > Regulations 
The 21 CFR Part 11 - Signature Regulation is pre-configured (Read only field) to request signatures before performing 
the action. 

Note 

The default value limits of the field are subject to Regulatory defaults. 

It has 2 states, - True or - False. If the check box is set to True, an Authentication Signature will be requested 
that ONLY Users groups with Sign access rights allocated to this Security zone can complete before the changes can 
take effect. If False, an Authentication Signature will NOT be requested. 
This is configured in the database for all Security items types. 

To configure this 

1. Click the Signing check box. 

 indicates that an Authentication Signature will be requested by this Security item type in this Security zone. 

 indicates it will NOT be requested. 

Note 

This is also referred to as the ‘Sign for Annotation’ field in the Review and QuickChart software Security items 
types. 

2. Finally, save changes and proceed to the next task. 

4.36.96 Configure the Start/Reset Timers access rights 

This check box allows or does not allow the Users assigned to the selected User group to start and reset the timer (if 
the option is fitted) either directly from the configuration page or by setting a timer job. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to control the timer, if 
the option is fitted. If False, the User group has been denied the access rights. 
This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Click the Start/Reset Timers check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.97 Configure the Synchronise Files access rights 

This field allows the selection of a type of confirmation via a drop down list, needed before deploying (pressing 
CRTL+SHIFT+H keys) the latest version of selected files to specified locations using the ‘InTouch WindowViewer’. 
InTouch WindowViewer > About/Help/Information > Synchronise Files 

Note 
The feature mimics the File Reconcile Utility by deploying the latest version of selected files to specified locations. 

This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 

4.36.98 Configure the System User writes access rights 

This field allows the selection of which field writes are logged for system Users, as defined in the User tab. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of system reporting required from a drop down list, as described above. 

2. Finally, save changes and proceed to the next task. 

4.36.99 Configure the Tag Security Area access level fields 

These Tag Security Area access level fields are used to associate Tag Security Areas, created using ‘Project Organiser’, 
with defined access level enumeration's. 

Note 
Remember, Tags can ONLY be edited by Users with Access Levels equal or greater than the selected value. 

To configure this 

1. Select the Tag Security Area from the drop down list in the last available field. A row is automatically added when 
the last field in either column is configured. 

 

2. Select the appropriate Access Level from the drop down list in the corresponding right hand field. 

3. Finally, save changes and proceed to the next task. 
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4.36.100 Configure the TagEdit access rights 

This check box allows or does not allow the Users assigned to the selected User group to edit Tags in the 

 On-line ‘Tag Browser’ (in Plant Units, Alarm Groups and Networks) 

 menu item on the ‘Point Page menu’ via the ‘InTouch WindowViewer’ 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to edit Tags in the 
Online ‘Tag Browser’. If False, the User group has been denied the access rights. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Click the TagEdit check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.101 Configure the Task Switch access rights 

This field allows the selection of a type of confirmation via a drop down list, needed when accessing the operating 
system environment (pressing ALT+TAB keys) via the ‘InTouch WindowViewer’. 

It is recommended that the action remains disabled at all times 

This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 

4.36.102 Configure the Transfer Files access rights 

This check box allows or does not allow the Users assigned to the selected User group to transfer data into the Review 
database by any of the manual routes. 

Note 
The Automatic Backup/Transfer continues irrespective of permissions of current user. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to transfer the data to 
the Review database. If False, the User group has been denied the access rights. 
This is configured in the database for the Review software item type. 

To configure this 

1. Click the Transfer Files check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 
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4.36.103 Configure the Trend Global access rights 

This field allows the selection of a type of confirmation via a drop down list, needed to accept changes to other Users 
configured Trend data in the ‘InTouch WindowViewer’. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 

4.36.104 Configure the Trends access rights 

This field allows the selection of a type of confirmation via a drop down list, needed to accept only changes to their 
own configured Trend data in the ‘InTouch WindowViewer’. 
This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Select the type of confirmation required from a drop down list, as described above. 

 

2. Finally, save changes and proceed to the next task. 

4.36.105 Configure the User1 to User4 access rights 

This field allows or does not allow the indicated User to perform a customer-defined function. 
This is configured in the database for Visual Supervisor Security items. 

To configure this 

1. Click the User1 or appropriate checkbox. 

 indicates the User perform a customer-defined function. 

 indicates the User is not permitted to perform a customer-defined function. 

2. Finally, save changes and proceed to the next task. 
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4.36.106 Configure the View Only access rights 

This check box allows or does not allow the Users assigned to the selected User group to enable or disable write access 
to the controllable features in all T800 Visual Supervisor Security items in the zone. This ensures the Users in the User 
group can only view the instrument information. 
This is configured in the database for Visual Supervisor Security items. 

To configure this 

1. Click the View Only checkbox. 

 indicates that Users in this User group can ONLY VIEW the controllable features. 

 indicates the Users can edit controllable features. 

2. Finally, save changes and proceed to the next task. 

4.36.107 Configure the View Security Data access rights 

This check box allows or does not allow the Users to view and print all Security data. 

It has 2 states, - True or - False. If the check box is set to True the User group is allowed to view and print all 
Security data. If False, the User group has been denied the access rights. 
This is configured in the database for the Security Manager Security item type. 

To configure this 

1. Click the View Security Data check box. 

 indicates that the User group is allowed to use this action. 

 indicates the Users assigned to the selected User group will have insufficient access rights. 

2. Finally, save changes and proceed to the next task. 

4.36.108 Configure the With unapplied changes field 

This field allows or does not allow the Users assigned to the selected User group to specify the consequences to any 
unsaved changes when the Login timeout period has elapsed. 
The drop down list displays the Discard Changes and Ignore timeout. 

It is recommended that this is configured as Discard Changes, as this will ensure that when the Login timeout period has 
elapsed the instrument will automatically logout, whereas if configured as Ignore timeout, changes to the instrument 
values are retained but the database remains open and is susceptible to access from unauthorised Users. 

This is configured in the database for 5000 and 6000 Series instrument Security items. 

To configure this 

1. Select Discard Changes or Ignore timeout from a drop down list, as described above. 

2. Finally, save changes and proceed to the next task. 
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4.36.109 Configure the downloaded Recipes field 

These field enables a system User Id (‘ESDataSrv’ system User Id can be created when adding a Computer Security item 
for this purpose) to be assigned to a selected Recipe. A Recipe is downloaded to a known location, then the designated 
User Id is allowed to start the Recipe, which thereafter is controlled by the system. 

Note 
Remember to configure the type of confirmation via a drop down list required to allow the Recipe Download to proceed. 

This is configured in the database for EurothermSuite PC Security item type. 

To configure this 

1. Enter the following data, into the first blank left hand field. 

<File Name including full path name>/<Unit>/<Recipe> 
A row is automatically added when the last field in either column is configured. 

 

2. Select the system User Id designated to start the Recipe from the drop-down in the appropriate right hand field. 

3. Finally, save changes and proceed to the next task. 
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5 EDITING PARAMETERS 

5.1 CHANGE THE USER ID 

This is a Read Only column but is incremented when Users are added. 

5.2 CHANGE THE PASSWORD FIELD 

This field is edited within the constraints configured in the User Global tab, to change the password before the User can 
access a Security database. 

Note 
When changing the password at a client database, confirmation is required by a second authorised User. 

1. Select the appropriate User’s ‘Password’ field. 

Note 
If the value is NOT highlighted double click in the field. 

 

2. Enter a new case-sensitive password value which does not exceed the selected Regulatory value constraints and 
press the return key. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field. 

Click ‘Ok’ to return this field to its previous setting and then attempt the change again. 

 

3. Read the information on the dialog window requesting password re-entry, and confirm by clicking the ‘Ok’ button. 

 

4. In the same field as before enter the identical password again. 

Note 
Passwords are displayed as ‘xxxxxxxx’. 

5. Finally save changes. 
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5.3 CHANGE THE CHANGE PASSWORD FIELD 

This field is edited to enable or disable the need for a User to change the password when attempting to login for the 
first time. 

1. Select the appropriate Users ‘Change password’ field. 

2. Select the appropriate indicator. 

Note 
If False, the User will NOT be requested to change the Password. If True, when the User next attempts to login a prompt 

appears requesting a change of password. 

 

3. Finally save changes. 

5.4 CHANGE THE PASSWORD EXPIRY TIME PERIOD 

Change this field to increase or decrease the minimum number of days until a password expires and requires changing. 

1. Select the appropriate Users ‘Password expiry’ field. 

Note 

If the value is NOT highlighted double click in the field. 

 

2. Enter a value which does not exceed the selected Regulatory value constraints and press the return key. 

Note 

If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the 
field. Click ‘Ok’ to return this field to its previous setting and then attempt the change again. 

 

3. Finally save changes.  
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5.5 CHANGE THE REMOTE USER ID 

This field is edited to enable the User access to a Security database via a 5000 Series instrument. 

1. Select the appropriate User’s ‘Remote User Id’ field. 

Note 
If a value is NOT highlighted double click in the field. 

2. Enter a value which does not exceed the selected Regulatory value constraints and press the return key. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field. 

Click ‘Ok’ to return this field to its previous setting and then attempt the change again. 

 

3. Finally save changes 

5.6 CHANGE THE REMOTE PASSWORD FIELD 

This field is edited within the constraints configured in the Minimum and Maximum Password Length fields on the User 
Global tab, to change the password before the User can access a Security database via a 5000 Series instrument. 

1. Select the appropriate User’s ‘Remote password’ field. 

Note 
If a value is NOT highlighted double click in the field. 

2. Enter a new case-sensitive password value which does not exceed the selected Regulatory value constraints and 
press the return key. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field. 

Click ‘Ok’ to return this field to its previous setting and then attempt the change again. 

 

3. Read the information on the dialog window requesting password re-entry, and confirm by clicking the ‘Ok’ button. 

 

4. In the same field as before enter the identical password again. 

Note 
Passwords are displayed as ‘xxxxxxxx’. 

5. Finally save changes 
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5.7 CHANGE THE ENABLED FIELD 

Change this field to indicate the User has been denied access to the Security database. 

1. Select the appropriate Users Enabled field. 

2. Select appropriate indicator. 

Note 
True indicates a User account as Active. False identifies a User account as Locked out. 

 

3. Finally save changes. 

5.8 CHANGE THE FULLNAME FIELD 

Change this field to enter an appropriate name for the User account. 

1. Select the appropriate Users ’Fullname’ field. 

If a value is NOT highlighted double click in the field. 

 

2. Enter a value which does not exceed the selected Regulatory value constraints and press the return key. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field. 

Click ’r;Ok’ to return this field to its previous setting and then attempt the change again. 

 

3. Finally save changes. 
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5.9 CHANGE THE SYSTEM FIELD 

Change this field to identify an account used to perform system functions. 

1. Select the appropriate ‘System’ field. 

2. Select appropriate indicator. 

Note 
True indicates the account is used by the system. False identifies it as a User account. 

 

3. Finally save changes. 

5.10 CHANGE THE RETIRED FIELD 

Change this field to terminate the selected User account, thus preventing the selected User access to the Security 
database. 

1. Select the ‘Retired’ field associated with the User who is to be terminated. 

2. Select ‘True’ from the drop down list. 

All records of Retired accounts compliant to the Default Regulation are removed, whereas records of Retired accounts 
compliant to the 21 CFR Part 11 are retained, (greyed out in the User tab). 

Note 
The effect is immediate (i.e. there is NO confirmation requested for this action.) 

Note 
Only accounts Retired AFTER the LAST save can be re-instated. These Retired accounts can be re-instated using the File > 

Discard Changes option. This causes ALL unsaved changes to be discarded, thus re-instating the terminated account. 

 

3. Finally save changes. 
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5.11 CHANGE THE REASON FIELD 

This is a Read Only column automatically describing the cause that resulted in the User to be Locked out. 
This field automatically describes the cause that resulted in the User to be Locked out. 
If there is a number of reasons ONLY 1 is displayed at a time but each MUST be dealt with before the User can access 
the Security database. 

 
A User can be Locked out if the, 

 User account has been disabled (‘Enabled’ field reads ‘False’, Reason field reads ‘Account disabled’) 

 login attempts have been exceeded 

 password has expired 

5.12 CHANGE THE LOGIN DIALOG TIMEOUT 

Change the numeric value to increase or decrease the amount of time a Login prompt window will remain displayed 
before automatically logging out. 

Note 
This timeout value only applies to the T800/ Eycon™10/20 Visual Supervisor Login dialog. 

1. Click the editable ‘Login dialog timeout’ field. 

Note 
The existing value is highlighted. If the value is NOT highlighted double click in the field. 

 

2. Enter the value that does not exceed the selected Regulatory value constraints. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field 

and then click ‘Ok’ to return this field to its previous setting. 

 

3. Finally save changes. 
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5.13 CHANGE THE KEEP RETIRED USER ID 

Change this field to allow User Ids and Passwords to be stored in the Project database or to be erased when the User is 
configured as retired. 

1. Click the ‘Keep retired User Ids’ field to reveal the True/False menu. 

2. Select either 

• True, to retain ALL User accounts and remain compliant with 21 CFR part 11 guidelines, or 

• False, to allow retired User accounts to be erased. 

Note 
All records of Retired accounts compliant to the Default Regulation are removed, whereas records of Retired accounts 

compliant to the 21 CFR Part 11 are retained, (greyed out in the User tab). 

3. Finally save changes. 

5.14 CHANGE THE PASSWORD REUSE PERIOD 

Change this field to increase or decrease the minimum number of days before an expired password may be used again. 

1. Click the editable ‘Password reuse period’ field. 

Note 
The existing value is highlighted. If the value is NOT highlighted double click in the field. 

 

2. Enter the value that does not exceed the selected Regulatory value constraints. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field 

and then click ‘Ok’ to return this field to its previous setting. 

 
3.         Finally save changes. 
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5.15 CHANGE THE MAXIMUM USER ID LENGTH 

Change this field to increase or decrease the maximum number of characters used by for ALL User Id’s in the database. 

1. Click the editable ‘Maximum User Id length’ field. 

Note 
The existing value is highlighted. If the value is NOT highlighted double click in the field. 

 

2. Enter a value of between 3 and 8 which does not exceed the selected Regulatory value constraints. 

Note 
If a value entered exceeds the constraints, a dialog window appears. Read the dialog indicating the constraints of the field 

and then click ‘Ok’ to return this field to its previous setting. 

 

3. Finally save changes. 
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6 DEFAULT ACCOUNTS 
These accounts are allocated to the default ‘Administrators’ User group in the Security Manager zone. 

Note 
Earlier Security Manager versions use the User Id - EPA (NOT case-sensitive), Password - EPAEPA (case-sensitive). 

6.1 DEFAULT ACCOUNT 1 

User Id - ADMIN (NOT case-sensitive), Password - ADMIN (case-sensitive). 

6.2 DEFAULT ACCOUNT 2 

User Id - ADMIN2 (NOT case-sensitive), Password - ADMIN2 (case-sensitive). 
The default Access Rights vary depending on the Regulation selected. 

6.3 INCORRECT USER ID OR PASSWORD 

An incorrect User Id or Password results in the display of the Invalid User Id/Password dialog box. It timeouts after 
approximately 30 seconds or can be closed by clicking the 'Ok' button. 

6.4 ACCESS LEVEL ENUMERATIONS 

Numeric values may be entered instead of the enumerations. 

 

6.5 TAGEDIT AND ESDATASRV USER ACCOUNT 

When TagEdit is used with the configuration tools the User does not have to login, instead TagEdit uses the system User 
Id, ESDataSrv. The ESDataSrv account can be created when adding a Security item. Therefore if security is enabled, it is 
necessary give ESDataSrv the necessary Access Levels to the Tag Security Areas. 

6.5.1 What is a Tag Security Area? 

Tags are assigned to Tag Security Areas (formerly Security Areas) using TagEdit. When User groups are allocated to 
Security zones they can be assigned an Access Level to selected Tag Security Areas. This determines what privileges the 
User has when writing to Tags within the selected Tag Security Area. 

EXAMPLE 1 - TAG SECURITY AREA ACCESS LEVELS 

This table shows that Users in User group 1 have Operator Access Levels which is sufficient the edit Tag1 and Tag3 in 
Tag Security Area 3 and Tag5 and Tag6 in Tag Security Area 6, but insufficient to edit Tag2 in Tag Security Area 2. 

User group Access Level Tag Location Tag Security Area Tag Access Level 

Operator (UG1) Tag1, and 
Tag3 

PC_12 Tag Security Area 3 Operator (8000) 

Operator (UG1) Tag2 PC_12 Tag Security Area 2 Engineer (16000) 

Operator (UG1) Tag5 and 
Tag6 

PC_4 Tag Security Area 6 Read only (0) 
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7 PASSWORD MENU 

7.1 CHANGE PASSWORD 

This section assumes that a User is currently logged in. This field permits the current Users password to be changed. 
The current Users password can be changed by, 

1. Selecting ‘Password > Change Password’ from the Menu bar. 

 

2. When this option is selected, the current User Id is shown at the top of the blank prompt window. Select the 
Current Password field and enter the correct Current Password. 

3. Select the New Password field and enter a new Password. 

4. The new password must be confirmed by entering the identical, case-sensitive password in the Confirm Password 
field. 

 

5. When all fields have been completed, accept the changes by clicking ‘OK’. To discard and return to the previous 
password select ‘Cancel’. 
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8 DELETE A SECURITY ITEM 
This function removes the object and all its configured parameters from the database. 

Delete a Security item by, 

1. Selecting the item that is not required. 

Note 
The Security item type and name are displayed in the relevant fields. 

 

2. Press the . 

3. A confirmation dialog window appears. Press ‘Ok’ to delete the item or ‘Cancel’ to reject the operation and return 
to the Security item element. 

 

Note 
If ‘Ok’ was selected observe the item has been removed. 

4. Finally save changes. 

8.1.1 Address 

Displays the Security item address. This describes the location of the Security item security database by either Project 
path (EurothermSuite PC), Computer Name and Security database path (Review and QuickChart Software), IP address or 
Host Name (5000 and 6000 Series instrument) or 'Lin port name' and 'Lin db name' (Visual Supervisor instruments). 

8.1.2 Security items display field 

Displays all configured Security items, including item specific data such as the Type (Computer, Software and 
instruments), Name (Security item name), Configuration Rev (last deployed master security database revision), 
Operational Rev (latest revision of the local security database) and the Status (Specific errors status). 
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8.1.3 Recover Security Manager/PC Security Database 

A Recovery User account is essential to recover an unusable security database. It relies on an Administrator enabling the 
Security Manager Recovery User account before the Security database becomes inaccessible. 

Note 

If the Recovery User account is NOT configured at any time before the system becomes inaccessible, the Recovery 
User account will NOT made be available. 

The database has an Recovery User account that allows a User to login to a database that does NOT have sufficient 
active Administrator accounts with full Access Rights. If the database has insufficient active Administrator accounts this 
could be due to, 

 passwords expiring or being forgotten 

 exceeding the Maximum Login attempt limits 

 disabled Administrator accounts 

8.1.4 Recover an unusable Security Manager/PC Security Database 

If the Recovery User account has already been configured it will be possible to recover an unusable Security database. 
Use the following instructions in order to do so. 

1. Contact the supplier stating the problem. The supplier will issue a time restricted (1 day), date dependent password. 

2. Open and login to the database before the 1-day limit expires. Do NOT use a User Id and enter the special issued 
password. 

3. The database opens enabling the User to re-instate sufficient accounts reactivating the security project. 

 

8.1.5 Recover Visual Supervisor Security Database 

A Recovery User Account is essential to recover an unusable database. It relies on an Administrator enabling the Visual 
Supervisor Recovery account before the Security database becomes inaccessible. 

Note 
If the Recovery User account is NOT configured at any time before the system becomes inaccessible, the Recovery 

User account will NOT made be available. 

If configured the Visual Supervisor has a Recovery account that allows a User to login to a Security database that does 
NOT have sufficient active Administrator accounts with full access rights. If this item has insufficient active Administrator 
accounts this could be due to, 

 passwords expiring or having been forgotten. 

 the Maximum Login attempt limits being exceeded. 

 Administrator accounts being disabled. 
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8.1.6 Recover an unusable Visual supervisor Security database 

If the Recovery account has already been configured it will be possible to recover an unusable Security database. Use 
the following instructions in order to do so. 

1. At the instrument, press the ‘RECOVER’ button (this temporarily replaces the ‘USERS’ button), to display a window 
containing a number. The number is derived from instrument specific data, date and time. 

Note 
Write down the number. 

2. Contact supplier stating the problem and instrument specific number. The supplier will issue a time restricted (1 
hour), date dependent password. 

3. Open and login to the instrument before the 1 hour time limit expires. Do NOT use a User Id and enter the special 
issued password. 

 

4. This opens the Security database, enabling the User to re-instate sufficient accounts, therefore reactivating the 
Security database. 
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9 PC CONFIGURATION 
This function enables the User to restrict the use of the master security database. This database is unrestricted until the 
‘Enable PC Locking’ field is checked, after which the database is restricted to the list of computer’s in the ‘PC 
Configuration’ dialog window. This is also a default list of computers for use with the AutoDeployment zone. 
If the ‘Enable PC Locking’ field is selected before any computer’s have been added a dialog window appears warning 
that this function is NOT enabled. 

9.1 TO SETUP THE PC CONFIGURATION 

When PC Configuration is selected, a dialog window appears. It is configured by adding computer’s to a list, deleting 
them from the list, enabling computer locking and confirming the operation. 
The User needs to know the PC Name, and PC Code of the computer before attempting to add it to the list. 

1. Select ‘Options > PC Configuration’ from the Menu Bar. 

 

2. A dialog window to appears. Firstly, make sure the ‘Enable PC Locking’ is disabled. Using the keyboard enter the 
PC Name and PC Code in the appropriate fields and press the ‘Add PC’ button.  If attempting to add the computer 
currently in use click the ‘Add this PC’ button. 

3. Observe the computer Name and Code have been entered in the list. ALL computers on the list remain at ‘ADD’ 
status until confirmed. 

Note 

Any computer at the ‘ADD’ status may be deleted without confirmation. 

4. Press ‘Ok’ to confirm and update the computer’s status from ‘add’ to ‘existing’. 

• Use the Cancel button to ignore the changes. 

 

9.2 CANCEL PC CONFIGURATION 

Operate this button to stop the computer configuration procedure and revert to the current Security Manager 
Window.A prompt appears if there is unsaved changes, select as appropriate. 
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10 CUSTOMISE SECURITY MANAGER 

10.1 HOW TO SHOW ACTIVE OR ALL USERS 

The function of this button allows the User to display ALL Users or just the Active Users in the User Id column. 

Display Active or All users by 

1. Clicking and observe the list of User Id’s as it is reduced to show just the Active Users. The 

button now reads . 

Note 

If the tab was already showing just the Active Users, pressing the  causes the list of User Id’s to expand 
and show ALL Users, including disqualified Users. 

 

2. Finally save changes. 

10.2 HOW TO HIDE/SHOW TOOLBAR 

The Toolbar stores 2 icons that enable quick access to the Open and Save options. It is displayed by default and is 
located at the top of the Security Manager window. A check mark along side this option in the View pulldown indicates 
it is currently displayed. 
Hide/show this bar by, 

1. Select ‘View > Toolbar’ from the Menu Bar. 

 

2. The Toolbar is removed from the window. 

 

3. To display the Toolbar, repeat the instructions. 
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10.3 HOW TO HIDE/SHOW STATUS BAR 

The Status Bar displays Security Manager database status information, including location, current user, security status, 
date and time. It is displayed by default and is located along the foot of the Security Manager window. A check mark 
indicates it is currently displayed. 

To hide/show this bar by, 

1. Selecting ‘View > Status Bar’ from the Menu Bar. 

 

2. The Status Bar is removed from the window. 

 

3. Repeat the instructions to display the Status Bar. 
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11 EUROTHERMSUITE PC SECURITY LEVEL NAMES 
This function shows the Security level names and the corresponding Access level values. The Security level name is 
used to define the level of security required by a User when attempting to edit a Tag. However, editing these fields is 
permitted. 

Note 
Editing these fields will require further configuration of the Project Database, and may not benefit the security 

configuration. 

To add a new EurothermSuite Pc security level, 

1. Select ‘Options > EurothermSuite Pc's security level names’ from the Menu Bar. A dialog window appears. 

 
It is recommended that the existing access level values remain as shown. However, editing the Security level name, may 
clarify security levels for each unique system. 

2. Double-click the next available Security level name field and enter the required text. 

3. Double-click the corresponding Access level field and enter the required value. 

4. Press ‘Ok’ to reveal the confirmation dialog. Press Yes to confirm the new EurothermSuite Pc Security parameters. 

Note 
The EurothermSuite Pc Security parameters can be removed, simply by deleting the Security level name text and corresponding Access 

level value. Confirmation will be required. 
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12 REGULATORY DEFAULTS 
Each Security Manager field has a defined range dependant on the selected Regulation. Any value that deviates from 
the Regulatory defaults will a breach of the defined Regulations, creating a system that now does NOT comply with 
those Regulations. 

12.1 SECURITY MANAGER REGULATORY DEFAULTS 

This table lists the Regulatory defaults for SecMan security item. 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 
Records 

21 CFR Part 11 
Signatures 

 

Default Range Default Range Default Range 

User Global 
      

Login Dialog Timeout 
(secs) 

0 0 30 
000 

0 0 30 
000 

0 0 120 

Max login attempts 0 0 30 
000 

3  3 99 3 3 99 

Keep retired user ids True True / 
False 

True (Locked) True (Locked) 

Minimum user id 
length 

3 3 8 6 3 8 6 3 8 

Maximum user id 
length 

8 3 8 8 3 8 8 3 8 

Minimum password 
length 

3 3 8 6 3 8 6 3 8 

Maximum password 
length 

8 3 8 8 3 8 8 3 8 

Password Reuse Period 
(days) 

0 0 30 
000 

365 365 30 
000 

365 365 30 
000 

User 
      

User Id Read Only User Id Read Only User Id Read Only User Id 

Password 3 3 8 6 3 8 6 3 8 

Change Password False True / 
False 

False True / 
False 

False True / 
False 

Password Expiry 0 0 30 
000 

90 1 180 90 1 180 

Remote User Id blank 0 20 blank 0 20 blank 0 20 

Remote Password 3 3 8 6 3 8 6 3 8 

Fullname blank 0 25 blank 0 25 blank 0 25 

System False True / 
False 

False True / 
False 

False True / 
False 

Retired False True / 
False 

False True / 
False 

False True / 
False 

Enabled True True / 
False 

True True / 
False 

True True / 
False 

Login Attempts Incrementing Value 
(Locked) 

Incrementing Value 
(Locked) 

Incrementing Value 
(Locked) 

Locked Out True / False 
(Locked) 

True / False 
(Locked) 

True / False 
(Locked) 

Reason Description 
(Locked) 

Description 
(Locked) 

Description 
(Locked) 

User Group 
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There are no Regulatory requirements for this Section 

 

Security item       

 

There are no Regulatory requirements for this Section 

 

Security Zone       

 

There are no Regulatory requirements for this Section 
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12.2 5000 SERIES INSTRUMENT REGULATORY DEFAULTS 

This table lists the Regulatory defaults for 5000 Series security items. 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 - 
Records 

21 CFR Part 11 - 
Signature 

 Default Range Default Range Default Range 

Management Data       

Record Logins False True / 
False 

True (Locked) True (Locked) 

Login Timeout 0 0 - 99 15 1 - 99 15 1 - 99 

with unapplied 
changes 

Ignore 
Timeout 

Ignore 
Timeout / 
Discard 
Changes 

Discard 
Changes 

Ignore 
Timeout / 
Discard 
Changes 

Discard 
Changes 

Ignore 
Timeout / 
Discard 
Changes 

Require Signing False True / 
False 

False True / 
False 

True (Locked) 

Require Authorisation False True / 
False 

False True / 
False 

False True / 
False 

Enable Audit Trail False True / 
False 

True (Locked) True (Locked) 

Disable Service 
Account 

False True / 
False 

False True / 
False 

False True / 
False 

Login by User Id True True / 
False 

True True / 
False 

True True / 
False 

Password Change on 
Expiry 

True True / 
False 

True True / 
False 

True True / 
False 

       

Access Rights       

Connect from remote False True / 
False 

False True / 
False 

False True / 
False 

Edit own password True True / 
False 

True True / 
False 

True True / 
False 

Change alarm 
setpoints 

False True / 
False 

False True / 
False 

False True / 
False 

Acknowledge alarms True True / 
False 

False True / 
False 

False True / 
False 

Edit Maths Constants False True / 
False 

False True / 
False 

False True / 
False 

Reset Maths False True / 
False 

False True / 
False 

False True / 
False 

Preset Totalisers False True / 
False 

False True / 
False 

False True / 
False 

Start/Reset Timers False True / 
False 

False True / 
False 

False True / 
False 

Set Clock False True / 
False 

False True / 
False 

False True / 
False 

Adjust Inputs False True / 
False 

False True / 
False 

False True / 
False 

Archiving Control False True / 
False 

False True / 
False 

False True / 
False 

Save/Restore False True / 
False 

False True / 
False 

False True / 
False 
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Paste/Delete False True / 
False 

False True / 
False 

False True / 
False 

Full Configuration False True / 
False 

False True / 
False 

False True / 
False 

Full Security False True / 
False 

False True / 
False 

False True / 
False 

Batch Control False True / 
False 

False True / 
False 

False True / 
False 

Can Sign False True / 
False 

False True / 
False 

False True / 
False 

Can Authorise False True / 
False 

False True / 
False 

False True / 
False 

Event Permission (x 5) False True / 
False 

False True / 
False 

False True / 
False 

Edit Output Channel 
Default 

False True / 
False 

False True / 
False 

False True / 
False 

Action Demand Writes False True / 
False 

False True / 
False 

False True / 
False 
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12.3 6000 SERIES INSTRUMENT REGULATORY DEFAULTS 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 
Records 

21 CFR Part 11 
Signature 

 Default Range Default Range Default Range 

Management Data       

Record Logins False True / 
False 

True (Locked) True (Locked) 

Login Timeout 0 0 99 15 1 99 15 1 99 

with unapplied 
changes 

Ignore 
Timeout 

Ignore 
Timeout / 
Discard 
Changes 

Discard 
Changes 

Ignore 
Timeout / 
Discard 
Changes 

Discard 
Changes 

Ignore 
Timeout / 
Discard 
Changes 

Require Signing False True / 
False 

False True / 
False 

True (Locked) 

Require Authorisation False True / 
False 

False True / 
False 

False True / 
False 

Enable Audit Trail False True / 
False 

True (Locked) True (Locked) 

Disable Service 
Account 

False True / 
False 

False True / 
False 

False True / 
False 

Login by User Id True True / 
False 

True True / 
False 

True True / 
False 

Password Change on 
Expiry 

True True / 
False 

True True / 
False 

True True / 
False 

Access Rights       

Connect from remote False True / 
False 

False True / 
False 

False True / 
False 

Edit own password True True / 
False 

True True / 
False 

True True / 
False 

Change alarm 
setpoints 

False True / 
False 

False True / 
False 

False True / 
False 

Acknowledge alarms True True / 
False 

False True / 
False 

False True / 
False 

Edit Maths Constants False True / 
False 

False True / 
False 

False True / 
False 

Reset Maths False True / 
False 

False True / 
False 

False True / 
False 

Preset Totalisers False True / 
False 

False True / 
False 

False True / 
False 

Start/Reset Timers False True / 
False 

False True / 
False 

False True / 
False 

Set Clock False True / 
False 

False True / 
False 

False True / 
False 

Adjust Inputs False True / 
False 

False True / 
False 

False True / 
False 

Archiving Control False True / 
False 

False True / 
False 

False True / 
False 

Save/Restore False True / 
False 

False True / 
False 

False True / 
False 

Paste/Delete False True / 
False 

False True / 
False 

False True / 
False 
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Full Configuration False True / 
False 

False True / 
False 

False True / 
False 

Full Security False True / 
False 

False True / 
False 

False True / 
False 

Batch Control False True / 
False 

False True / 
False 

False True / 
False 

Can Sign False True / 
False 

False True / 
False 

False True / 
False 

Can Authorise False True / 
False 

False True / 
False 

False True / 
False 

Event Permission (x 5) False True / 
False 

False True / 
False 

False True / 
False 

Edit Output Channel 
Default 

False True / 
False 

False True / 
False 

False True / 
False 

Action Demand Writes False True / 
False 

False True / 
False 

False True / 
False 

Perform Update False True / 
False 

False True / 
False 

False True / 
False 
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12.4 EUROTHERMSUITE PC REGULATORY DEFAULTS 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 
Records 

21 CFR Part 11 
Signature 

 Default Range Default Range Default Range 

Management Data       

Audit Trail True True / 
False 

True (Locked) True (Locked) 

Signing True True / 
False 

True True / 
False 

True (Locked) 

Authorisation True True / 
False 

True True / 
False 

True True / 
False 

Alarm Signing 0 0 15 0 0 15 0 0 15 

Alarm Authorisation 0 0 15 0 0 15 0 0 15 

Confirmation False True / 
False 

False True / 
False 

False True / 
False 

Notes False True / 
False 

False True / 
False 

False True / 
False 

Auto Logon User Id Blank (User Id 
needed) 

Blank (User Id 
needed) 

Blank (User Id 
needed) 

Log Invalid Times False True / 
False 

False True / 
False 

False True / 
False 

Audit Ports (x4) Blank (Port name 
needed) 

Blank (Port name 
needed) 

Blank (Port name 
needed) 

Lockout Level None None None 

    

Access Rights       

Sign False True / 
False 

False True / 
False 

False True / 
False 

Authorise False True / 
False 

False True / 
False 

False True / 
False 

Print False True / 
False 

False True / 
False 

False True / 
False 

TagEdit False True / 
False 

False True / 
False 

False True / 
False 

Operator Point Display False True / 
False 

False True / 
False 

False True / 
False 

Export Historical Trend False True / 
False 

False True / 
False 

False True / 
False 

Inactivity Timeout 
(secs) 

0 0 30 
000 

15 1 720 
15 1 720 

Display access level 0 0 9999 0 0 9999 0 0 9999 

Synchronise Files Each of the access rights in this part require  
the selection of a level of confirmation the  
default is No Confirmation 

Override Server 
Redundancy 

 

Task Switch 
 

Operator group global 
Level of 
Confirmation 

Level of 
Confirmation 

Level of 
Confirmation 
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No Confirmation 
Confirm Only 
Note 
Signature 
Sign & Note 
Sign & Authorise 
Sign & Authorise & 
Note 
Action Disabled 

No Confirmation 
Confirm Only 
Note 
Signature 
Sign & Note 
Sign & Authorise 
Sign & Authorise & 
Note 
Action Disabled 

No Confirmation 
Confirm Only 
Note 
Signature 
Sign & Note 
Sign & Authorise 
Sign & Authorise & 
Note 
Action Disabled 

 

Debug 

Operator groups 

Trend global 

AlarmHistMaxItems 

Trends 

Recipe Download 

Global Alarm 
Acknowledge 

Faceplate Modify 

Change Language 

Offline data writes 

IO data writes 

System User writes 

   

Recipes Needs appropriate 
configuration 

Needs appropriate 
configuration 

Needs appropriate 
configuration 

Tag Security Area 
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12.5 QUICKCHART SOFTWARE REGULATORY DEFAULTS 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 - 
Records 

21 CFR Part 11 - 
Signature 

 Default Range Default Range Default Range 

Management Data       

Sign for Annotation False True / 
False 

False True / 
False 

True (Locked) 

      

Access Rights       

Create QuickChart False True / 
False 

False True / 
False 

False True / 
False 

Open QuickChart True True / 
False 

True True / 
False 

True True / 
False 

Modify Chart View True True / 
False 

True True / 
False 

True True / 
False 

Save QuickChart False True / 
False 

False True / 
False 

False True / 
False 

Chart Setup False True / 
False 

False True / 
False 

False True / 
False 

Administration False True / 
False 

False True / 
False 

False True / 
False 

Chart Annotate False True / 
False 

False True / 
False 

False True / 
False 

Chart Review False True / 
False 

False True / 
False 

False True / 
False 

Chart Approve False True / 
False 

False True / 
False 

False True / 
False 

Chart Release False True / 
False 

False True / 
False 

False True / 
False 

Print True True / 
False 

True True / 
False 

True True / 
False 

Print Setup True True / 
False 

True True / 
False 

True True / 
False 

Export Data True True / 
False 

True True / 
False 

True True / 
False 

Export Setup True True / 
False 

True True / 
False 

True True / 
False 

Inactivity Timeout 
(secs) 

0 0 - 30 
000 

15 1 - 720 15 1 - 720 
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12.6 REVIEW SOFTWARE REGULATORY DEFAULTS 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 - 
Records 

21 CFR Part 11 - 
Signature 

 Default Range Default Range Default Range 

Management Data       

Sign for Annotation False True / 
False 

False True / 
False 

True (Locked) 

      

Access Rights       

Transfer Files False True / 
False 

False True / 
False 

False True / 
False 

Chart Setup False True / 
False 

False True / 
False 

False True / 
False 

Chart Open/Close True True / 
False 

True True / 
False 

True True / 
False 

Modify Chart View True True / 
False 

True True / 
False 

True True / 
False 

Save Chart False True / 
False 

False True / 
False 

False True / 
False 

Administration False True / 
False 

False True / 
False 

False True / 
False 

File Services False True / 
False 

False True / 
False 

False True / 
False 

Chart Annotate False True / 
False 

False True / 
False 

False True / 
False 

Chart Review False True / 
False 

False True / 
False 

False True / 
False 

Chart Approve False True / 
False 

False True / 
False 

False True / 
False 

Chart Release False True / 
False 

False True / 
False 

False True / 
False 

Print True True / 
False 

True True / 
False 

True True / 
False 

Print Setup True True / 
False 

True True / 
False 

True True / 
False 

Export Data True True / 
False 

True True / 
False 

True True / 
False 

Export Setup True True / 
False 

True True / 
False 

True True / 
False 

Inactivity Timeout 
(secs) 

0 0 - 30 
000 

15 1 - 720 15 1 - 720 
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12.7 VISUAL SUPERVISOR REGULATORY DEFAULTS 

This table lists the Regulatory defaults for T800/Eycon™10/20 Visual Supervisor security items. 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 - 
Records 

21 CFR Part 11 - 
Signature 

 Default Range Default Range Default Range 

Management Data       

Recovery User True True 
/ 
False 

True True 
/ 
False 

True True 
/ 
False 

Password Expiry 0 0 - 
180 

90 1 - 
180 

90 1 - 
180 

Inactivity Timeout 
(secs) 

0 1 - 
720 

15 1 - 
720 

15 1 - 
720 

       

Access Rights       

Sign False True 
/ 
False 

False True 
/ 
False 

False True 
/ 
False 

Authorise False True 
/ 
False 

False True 
/ 
False 

False True 
/ 
False 

View Only False True 
/ 
False 

False True 
/ 
False 

False True 
/ 
False 

Reference Number 0 0 - 
6553
5 

0 0 - 
6553
5 

0 0 - 
6553
5 

Access Level Operator Op. - 
Admi
n 

Operator Op. - 
Admi
n 

Operator Op. - 
Admi
n 

12.8 WINDOWS DOMAIN REGULATORY DEFAULTS 

This table lists the Regulatory defaults for Windows Domain security items. 

IMPORTANT NOTE 
Grey fields indicate a Read Only parameter. 

 Default 21 CFR Part 11 - 
Records 

21 CFR Part 11 - 
Signature 

 Default Range Default Range Default Range 

Management Data       

Administrator UserId Needs appropriate 
configuration 

Needs appropriate 
configuration 

Needs appropriate 
configuration 

Administrator 
Password 

0 0 - 180 90 1 - 180 90 1 - 180 

Password Expiry 0 1 - 720 15 1 - 720 15 1 - 720 

Deploy Existing Users True True / 
False 

True True / 
False 

True True / 
False 

Deploy Retired Users True True / True True / True True / 
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False False False 

       

Access Rights 
True True / 

False 
True True / 

False 
True True / 

False 

Groups Needs appropriate configuration 
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13 COMMAND LINE PARAMETERS 

13.1 PATH TO SECMANDB.UJX COMMAND LINE PARAMETER 

This Command line parameter should only be used to define the location of the Security database when operating the 
Security Manager through the Command line prompt. 
This can be configured in a string with other Command line parameters. 

Command line prompt example 

 
This Command line parameter will run the Security Manager Utility and load the defined SecManDb.ujx database. 
Security Manager can also be operated and MUST be started at the Deployment Computer using Command Line 
parameters. The following image indicates the parameters that can be configured using the command line prompt. All 
parameters are single space separated. 

 

NOTE 
This graphic is displayed using the /Help Command line parameter, it shows the parameters with the exception of the 

/AutoDeploy Command line. 
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13.2 /REGSERVER COMMAND LINE PARAMETER 

This Command line parameter should rarely be used, as the correct information should have already been configured 
when Security Manager was installed. 

Command line prompt example 

 
This Command line parameter will enter Security Manager registry data to allow the user to double click the 
SecManDb.ujx to open the database. 

/Help Command line parameter 

This Command line parameter will display the following list of available Command line parameters. 

Command line prompt example 

 

Note 
This graphic is displayed using the /Help Command line parameter, it lists each additional parameter. An /AutoDeploy 

Command line parameter has also been included. 

13.3 /LOGIN COMMAND LINE PARAMETER 

This can be configured in a string with other Command line parameters. 

Command line prompt example 

 
This Command line parameter will automatically enter defined User Id and Password in the Login prompt. 
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13.4 /SECURE COMMAND LINE PARAMETER 

This can be configured in a string with other Command line parameters. 

Command line prompt example 

 
This Command line parameter will stop any means of saving data by disabling the File > Open and File > Close options, 
the Help option, including the About dialog. 

13.5 /HIDETASKBAR COMMAND LINE PARAMETER 

This Command line parameter can be configured in a string with other Command line parameters. 

Command line prompt example 

 
This Command line parameter will ensure that when Security Manager is the Windows Task Bar, and any operations 
associated with it are NOT displayed on screen. 
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13.6 /AUTODEPLOY COMMAND LINE PARAMETER 

The Autodeploy function can be started from a Deployment computer either by the Command line prompt or via a 
shortcut to the Master Security database. 

It is recommended that the shortcut method is used, as this will cancel the need to enter the /Autodeploy Command 
line parameter each time in order to start Security Manager. 

For this facility to operate successfully, the Deployment computer MUST be, 

 specified in the Security zone 

 listed in the PC Configuration table (Options pulldown) 

 and the Deployable flag MUST be checked (Options pulldown) 

It can be configured in a string with other Command line parameters. 
This Command line parameter 

 displays the deployment dialog with full use of the Deploy and the ‘Deploy All/Zone’ buttons 

 compares the Master Security database revision with that of the Security items in the Security zone, and reconcile 
and deploy where necessary 

It is recommended that a sufficient time, specified in the command line, is allowed for the Autodeploy comparison to 
complete. Any value greater than 60 secs can be applied, but a default 300 secs is assumed if a value is not offered. The 
value must be changed according to the complexity of the system, with a minimum of 5 mins in a system comprised of 
5000 Series instruments. 

Command line prompt examples 

 
"SecMan" /AutoDeploy 60 "\\EuroPS\MyProject\SecManDb.ujx" 
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Shortcut example 

 

IMPORTANT NOTE 
The /Autodeploy Command line parameter, 

"SecMan" /AutoDeploy 60 "\\EuroPS\MyProject\SecManDb.ujx" 
MUST be entered in the Target field of the shortcut properties dialog box. 

13.7 /UNREGSERVER COMMAND LINE PARAMETER 

This Command line parameter should rarely be used, as the correct information should have already been configured 
when Security Manager was installed. 

Command line prompt example 

 
This Command line parameter will remove Security Manager registry data that will stop the user from opening the 
database. 
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14 AUDIT TRAIL INFORMATION 

14.1 SECURITY MANAGER AUDIT TRAIL 

This enables event and alarm trace-ability in the form of tamper-proof data storage files. A new file is created each time 
the database is opened. It is assigned a filename derived from the Database name (SecMan), computer name, 
Year/Month/Day, an issue number, and a .uhh extension. 

 
The Audit Trail is saved to the History directory in the Project folder. Each time an event or alarm occurs at an item 
configured in the database, an entry containing additional data is added to the Security Manager Audit Trail. There are 4 
event types each recording different information, 

 Non operator 

These are system or universal events that record Date, Time, and Action, Previous and New values (if appropriate). 

 Permitted 

These are events caused by User accessing nodes on the system. The Date, Time, Action, User Id and/or User name, 
Previous and New values (if appropriate) are recorded. 

 Signed 

These are events that require the User to enter a password to accept the changes. An optional Reason note 
accompanies these events. 

 Signed and authorised 

These events require 2 different User signatures. The first to sign (accept) a change and the second to authorise 
(confirm) the change. The authorisation signature is accompanied by the Users Fullname description. 
The Security Manager Audit Trail can be viewed and printed using the Review software. 

14.2 AUDIT TRAIL EVENTS 

An event is defined as the following: 

 Login/Logout. 

 Exceeded Login attempts. 

 Any saved configuration changes to the database. 

 Synchronise/Deploy the master database. 

 Security configuration audit. 

 Starting other applications. 

 Event alert failure. 

14.2.1 Audit Trail event details 

Each event is accompanied by the following data, 

 Time stamp. 

 Current User Id and Fullname. 

 Signing User Id and Fullname (if required). 

 An authorised User Id and Fullname (if required). 

 A description of the changes as part of an electronic signature (if required). 

14.3 21 CFR PART 11 

The 21 CFR (Code of Federal Regulations) Part 11 guidelines can be found on the FDA (Food and Drug Administration) 
web-site at the address below. 
www.access.gpo.gov/nara/cfr/waisidx_02/21cfr11_02.html 
A system can only be 21 CFR Part 11 compliant if enabled regulatory features do NOT exceed the regulatory parameter 
limits. 
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15 HELP MENU 

15.1 CONTENTS 

With the selection of this menu option, the ‘Help’ file is displayed with the ‘Contents’ command as the priority. 
To display this 

1. Select the ‘Help > Contents’ from the Menu Bar. 

 

2. The Security Manager On-line Help document appears in a new window. Use standard windows Help operations to 
use the On-line Help. 

15.2 INDEX 

With the selection of this menu option, the ‘Help’ file is displayed with the ‘Index’ command as the priority. 
To display this 

1. Select ‘Help > Index’ from the Menu Bar. 

 

2. The Security Manager On-line Help document appears in a new window. Use standard windows operations to use 
the On-line Help. 

15.3 SEARCH FOR HELP ON 

With the selection of this menu option, the ‘Help’ file is displayed with the ‘Search’ command as the priority. 
To display this 

1. Select ‘Help > Search For Help On’ from the Menu Bar. 

 

2. The Security Manager On-line Help document appears in a new window. Use standard windows operations to use 
the On-line Help. 
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15.4 ABOUT 

With the selection of this menu option, information about the utility is displayed including the name, version number, 
and description. 
Display the utility details by, 

1. Selecting ‘Help > About’ from the Menu Bar. 

 
2    The About dialog window appears. 

 
3    Select the ‘OK’ button to return to the previous window. 
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16 STATUS BAR 
The Status Bar displays Security Manager database status information, including location, current user, security status, 
date and time. It is displayed by default and is located along the foot of the Security Manager window. A check mark 
indicates it is currently displayed. 

16.1 HOW TO HIDE/SHOW STATUS BAR 

1. Open the View menu and click on the Status bar item to ‘untick’ it. 

 

2. The Status Bar is removed from the window. 

3. Repeat the instructions to display the Status Bar. 

16.2 STATUS BAR ITEMS 

16.2.1 Security Status 

This part of the Status Bar shows the current state of database. 

16.2.2 Security Manager Database Location 

This part of the Status Bar shows the full path location of the opened database. 

16.2.3 Security Manager Database icon 

 

16.2.4 Time 

This part of the Status Bar shows the current time. 

16.2.5 Date 

This part of the Status Bar shows the current date 
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17 ACTIVE DIRECTORY  

17.1 IMPORT USERS FROM ACTIVE DIRECTORY 

To import existing User Accounts from the Domain Server Active directory; 

1. Select  'Options > Import Users from Active Directory’ from the Menu Bar. 

 
 

2. A dialog window appears. Enter the 'Domain' DNS server name,  'Username' and 'Password' and select 
'Connect' 

IMPORTANT 
When importing users into 'Security Manager' from an active directory Domain  server, the DNS Domain name must be 

specified for the Domain server and NOT an IP address or NETBIOS name.  If the IP address is entered it will not be 
possible to authenticate users at the 'Instrument' level. 
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3. Once 'connection' with the domain server is established, the 'Group' field will contain a pick-list to select the 
required user group.  The screen shot above shows the 'Laboratory_3' Group  is selected, and the users contained within 
it are shown in the 'Users in Active Directory' selection box. 

4. Select each required user and transfer them to the 'Users to Import to Security Manager' box by using the 

transfer arrow;' '.  

5. Enter a 'Tick' into the 'Import users into Security group' box and then select the appropriate 'security group' 
from the pick-list   

6. Finally click the 'Import' button.  All selected users will then be imported into 'Security Manager'. 

Note 
All imported users will appear in the 'Users' page of 'Security Manager' including the Domain server name for each user. 

17.2 CHANGE THE DOMAIN PARAMETER 

This parameter contains the Domain server name.  The Domain name must be entered using the 'Import Users from 
Active Directory' facility found in the 'Options' menu. 

Note 
Active Directory is the system which provides your network logon credentials to access network resources, applications 

 and web sites requiring authentication 

1. If the parameter is 'blank' or states 'NONE', the user account is 'local' to 'Security Manager' only. 

2. If the parameter contains a Domain name, the user account has been imported from a company Domain server 
using the 'Import Users from Active Directory' facility.   

Note 
For users with a Domain name, they will always be enabled for deployment to a 6000 series recorder supporting Active 

Directory, unless 'retired' from 'Security Manager' 

 

 
 

3. Finally save changes. 
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18  OTHER INFORMATION 

18.1 WHAT IS A MASTER DATABASE? 

The master database is defined by the Master UNC (Universal Naming Convention) path configured using ‘Options > 
Master UNC path’ pulldown. Generally the master database is resident on a shared computer, where the Project was 
initially created. 
Example 
\\< shared Security item Computer name >\< directory >\< project folder > 

Note 
The computer name can be found by selecting 

Start > Settings > Control Panel > Network > Identification 

To give the computer, or to be more accurate the hard drive (C:), ‘shared’ access 

1. Select the computer hard drive icon, right click and select ‘Properties > Sharing tab’. 

2. Click the ‘Shared as’ radio button and type ‘C$’ into the ‘Shared name’ field. 

3. Press ‘OK’ to accept or ‘Cancel’ to exit the operation. 

18.2 WHAT IS A CLIENT DATABASE? 

This is a deployed copy of the master database. Generally it is resident on Security item nodes in the security 
configuration. 
Replication of a client database is NOT permitted and if attempted the User is requested to switch to the master 
security database before continuing. 

18.3 WHAT IS THE PC NAME/CODE? 

The computer Name is the computer identification name. 
The computer Code is a hexadecimal address value of the computer. 
These parameters are displayed when selecting a database ('Enable PC locking' MUST be enabled). 

18.4 DEFAULT LIN USER NAMES 

Unless the item being written to was added using the ‘.w’ qualifier, LINOPC will use the OPC group name as the User 
name. 
If it is not already known, it is possible to determine the OPC group names that have been created in LINOPC by 
running the LINOPC Groups application. 
Some clients may not specify a group name in which case LINOPC automatically creates group names of the form 
AutoGroup<nn>. 
If these applications are also using ‘Fully qualified addresses’ it will be necessary to add these group names into the 
‘defaccss.CSV’ file. For the clients that have group names automatically created the user name AutoGroup will need to 
be added, and will apply to all these clients. 
After installation ‘defaccss.CSV’ will normally be configured with the lines 
LinToolsOpc.<Logged in NT user>.<PC node name> , RW 
TheGroup, RW  
This defines the access for the clients LINTools and OPCScope. 
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18.5 DEFAULT LIN ACCESS 

If the client is addressing the LIN Blocks using Fully qualified addresses then LINOPC will not have a Tag Security Area 
for the block, and consequently will be unable to determine if the User has sufficient Access Level when writing to the 
blocks. LIN Tools and OPC Scope are examples of such clients. 
In this instance LINOPC uses the default LIN access defined in the ‘defaccss.CSV’ file. Each line of this file has the 
following format. 
<User name>, <RO | RW> 
Where  
RO = Read only 
RW = Read write 
LINOPC looks for this file first in the active Project folder, and then in the folder containing the Linopc.exe file. 
If LINOPC has to use the security defined in this file then a user will be granted either ‘RO’ or ‘RW’ access, irrespective 
of the block being written. 

18.6 LINOPC CLIENT SECURITY 

This function shows existing OPC Group names and the corresponding Access Type. Additional groups can be added, 
simply by entering the required group name text and selecting the appropriate OPC Access type. The OPC Group 
name is used to define the security for groups of Third-Party clients. 

18.6.1 To add OPC Group security, 

1. Select ‘Options > LINOPC Client Security’ from the Menu Bar. A dialog window appears. 

 

2. Double-click the next available LINOPC Group name field and enter the required text. 

3. Double-click the corresponding Access level field and select the required Access type. 

• NONE (No access) 

• RO (Read only access) 

• RW (Read write access – everything logged) 

• RWE (Read write access – only errors logged) 

• RWN (Read write access – nothing logged) 

4. Press ‘Ok’ to reveal the confirmation dialog. Press Yes to confirm the new LINOPC Security parameters. 

Note 

The LINOPC Security parameters can be removed, simply by deleting the LINOPC Group name text and the corresponding  

Access type value. Confirmation will be required. 
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18.6.2 LINOPC Security specifics 

Online LIN data is accessed through the LINOPC server. This program provides an OPC interface to the LIN Blocks. 
Through this interface LIN items are always be referred to by their Fully Qualified Address (FQA) (see Default LIN 
Access):- 
<Port name>’’NN:<Lin DB name>.<Block name>[.<Field name> | .<Sub field name> | .<Qualifier>] 
where, 
NN = LIN node address in hex. 
Or if a Project database is available, items may be referred to using their Tags, 
<Tag name>[.<Field name>][.<Sub field name>][.<Qualifier>] 
By default, LINOPC takes the OPC group name to which the item was added as the User name. However if the item has 
the ‘.w’ qualifier, the LIN User Name is extracted from the string that is written to the item. 
For example, if a client wishes to write the value ‘55.6’ to the ‘PV’ field of the ‘Tag’ ‘PID01’, the client adds the item 
[PID01.PV] 
and writes ‘55.6’ to it. In this instance LINOPC uses the OPC group name the item was added to as the User. 
Alternatively if the client wished to specify User ‘Jack’ on computer, i.e. ‘OpStn1’, signed for the change, the item could 
be added with the ‘.w’ qualifier. 
[PID01.PV.w] 
A ‘.w’ string value which has the following syntax would then be expected. 
[<PC Node>],[<User data>],[<Access level>],[<Qualifier>],[<Value type>:]<Value>[0] 
Where 
<User data> [Logged on user] / [Signing user] / [Authorising user] 
Currently only the [Logged on user] or the [Signing user] is used. The Access Level is checked against the [Signing ‘User’] 
if present. 
<Access level> If this value is specified it overrides the Users Access Level to the Tag defined in the security database. 
<Qualifier> not used 
<Value type> <s | d | f | x | o> 
<s> = string 
<d> = integer 
<f> = floating point 
<x> = hex 
o> = octal 
In this example it would be: - 
OpStn1, /Jack/, , ,f,55.6 
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18.7 TAG AND LINBLOCK SPECIFICS 

If the system includes Tags and LINBlocks it is important to have an understanding of the following features and how 
they relate to the elements of the Security Manager. 

 Tag Security Areas  

User groups are given Access Levels to Tag Security Areas. This determines the privileges required in order to write to 
the Tags in the Tag Security Areas in the selected Security zone. The Access Levels are defined as part of the Access 
Rights given to a User group. 

Note 
In systems that precede the Security Manager, these were known as Security Areas. When upgrading systems it is 

IMPORTANT not to confuse Tag Security Areas with Security zones. 

 Tag Profile Configurator  

The fields in a LIN block referenced by a Tag have a number of properties, including flags to indicate Electronic 
Signatures are required. By default these properties are contained in the template that describes the block. However, 
the Tag Profile Configurator can redefine these properties so that they are unique for each Tag. 

 LINOPC Security  

LINOPC applies its own security check to confirm that a client has the Access Level necessary to write to an online 
LINBlock. This is based on user names and Tag Security Areas. However some client processes do not refer to LINBlocks 
by their Tags, and do not explicitly specify user names, LINTools and OPCScope are two examples. The installation sets 
up the necessary information for known clients, however where a new OPC client is being integrated it is necessary to 
understand how LINOPC deals with security. 

 TagEdit and ESDataSrv user account  

When TagEdit is activated from one of the Project Developer tools, the User is not required to login. In this mode 
TagEdit uses ESDataSrv the default system User Id. ESDataSrv is one of the default accounts supplied with the Security 
database and must be given access to the Tag Security Areas to ensure TagEdit has the privilege to perform writes when 
security is enabled. 

18.7.1 Tag Profile Configurator specifics 

Each field associated with a Tag has actions relating to security which must be completed before any changes can take 
effect. 
By default these values are defined on a block type basis, however this configurator allows new pseudo LIN Block types 
to be created. The new types have the same LIN Template, i.e. fields as the original type, but security and other 
attributes stored in the Project Database can be changed from the default values. The new type is identified using the 
block type name, e.g. ‘PID’ plus a PointDisp name other than default, e.g. Boiler. Once the new type has been created in 
the Tag Profile Configurator the PointDisp field can be changed in TagEdit. Opening Tag Profiles in the Project folder 
runs this configurator which can also be used to configure various other field properties. 

18.7.2 Tag Security Areas specifics 

Each field in a block referenced by a Tag has an Access Level (a numeric value between 0 and 32767). A User wishing to 
write to that field would require an Access Level of at least this value. 
Each Tag can be assigned to a single Tag Security Area only. When Users login to a security item they are given an 
Access Level over each of the Tag Security Areas, that determines which fields in each Tag can be written to. 
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18.7.3 create a Tag Security Area (Project Organiser) 

Project Organiser must be used to create Tag Security Areas and configure the relevant Tags. 

Note:  Refer to Project Organiser help file for full instructions. 

Project Organiser is used to create Tag Security Areas and configure the relevant Tags. Security Manager is then used 
to assign User Access Rights to Tag Security Areas, allowing assigned Users to write to the Tags of that Tag Security 
Area. There are 2 default Tag Security Areas. 

 $SystemTag 

provides access to the LIN Write Failure flag. This is generated and viewed in InTouch when a write to a LIN server fails 
due to an invalid reference or insufficient security. This Tag Security Area includes all system Tags, for example, all Tags 
used to clear down the LIN write error counts. These Tags all require an Access Level of 10000. 

 UNALLOCATED (NULL) 

allows engineer security access to Tags NOT assigned to a Tag Security Area. Security Manager is used to assign the 
Unallocated (NULL) Tag Security Area to those User Groups. This Tag Security Area includes all Tags that have not 
been assigned to a Tag Security Area. 

Note:  Tags can only be assigned to a single Tag Security Area. 

This is configured by, 

In the Project Organiser 

1. Open the Project folder, and then Tag Security Areas. 

Note:  If creating the first Tag Security Area the Editor Contents Region is empty. 

2. Create the Tag Security Area to break the Project down into sufficient identifiable groups, 

• Right click to show the floating menu and select New > Tag Security Area. 

3. The command displays the New Tag Security Area dialog. In the Tag Security Area Name field, enter a short (12 
characters maximum) easily identifiable name for the Tag Security Area containing any of the following characters a z, A Z, 
0 9, &, _, -. 

For clarity, try to use an easily identifiable name for an object, i.e. Boiler3 (Tag Security Area). 

4. Select OK to accept the Tag Security Area name. Press Cancel, , or Esc. on the keyboard to abort the operation. 

5. Refresh the display, (View > Refresh (F5)) when complete. 

In the Security Manager, 

6. Configure the permission for the relevant Tag Security Area by selecting the appropriate level of security from the 
enumerated picklist of Access Levels. 

The Access Level a User has in each Tag Security Area is configured by the Security Manager.  An Access Level 
determines a minimum level of security permitted before the Tags it contains can be edited by a User assigned to a 
User group on a computer. 
The User group Tag Security Area Access Level is configured in a table, which allows the Access Levels to be defined. 

• Clicking in the left-hand column offers a picklist showing the configured Tag Security Areas. 

• Clicking in the right hand column offers an enumerated picklist of Access Levels. 
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.CSV FILES 

These comma separated variable (.csv) text files can be viewed using (for example) Microsoft Excel. 

DELETE 

Operating this button after selecting a computer will remove it from the list of computers that can access the master 
database.  Confirmation is required if at 'existing' status. 

NAVIGATION PANE 

This half of the window always lists the Security zones and User groups in alphabetical/numerical order. All items and 
groups are found using the  and  symbols. 
The selection of a heading within this pane displays the appropriate information in the Properties pane. 

LOGIN ATTEMPTS 

This field displays an instantaneous record indicating the number of continuous login failures attempted by each Active 
User. 
The field is reset to ‘0’ following a successful login. 

Note 
Any User exceeding the login attempts configured in the Maximum Login Attempts field on the User Global tab will be 

automatically Locked out. This will be indicated in the Reason column. 

LOCKED OUT 

This field displays an automatic record indicating whether the User may access the database. 
True indicates the User is Locked out (User Id row will be greyed out in the User tab). False identifies the User is NOT 
disqualified. 

 A User can be locked out by the Administrator’s setting ‘Enabled’ from ‘False’ to ‘True’ 

or automatically if 

 The number of permitted login attempts has been exceeded or, 

 the password has expired. 

ENABLED 

This field is edited to indicate the User account is denied access to the Security database. 
True indicates a User account as Active. False identifies a User account as Locked out. (see change the Enabled field) as 
indicated with ‘Account disabled’ displayed in the Locked out reason column. 

ENABLED 

This is a Read Only column indicating, 

 True, the Security item is enabled for Deployment, 

 False, the Security item is not enabled for Deployment. 

ENABLE PC LOCKING 

 When this box is checked ONLY the listed computer's may access the database. 

EXIT BUTTON 

Operating this button terminates the Security Manager Utility, returning to the Project Folder. 

FULLNAME 

This field is edited to enable the Security database to identify a User when used in conjunction with the corresponding 
password.  This field is initially blank but MUST be completed to enable the User to Login (see change the Fullname 
field). The name entered MUST always be unique. 

Note 
The default Password MUST also be changed to enable the User to Login. 

This field can only be configured within the selected Regulatory value constraints determined in the User Global tab. 

DOMAIN NAME 
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This field contains the Domain server name for user accounts associated with ‘Active Directory’.  If the field is blank, or 
states ‘NONE’, the user account has been established using Security Manager rather than the Domain server.   
If the field contains a Domain name, or if it is required to import user accounts from a Domain server, the user account 
must be imported using the ‘Import Users from Active directory’ facility. 
Note:  Active directory is a system which provides network logon credentials to allow the user access to network 
resources, applications and web sites requiring authentication. 

FILE NAME FIELD 

When the .CSV file is the selected output format, the saved electronic file is assigned a default SecManDb.CSV file 
name. The default SecManDb.CSV file name can be edited to enable the User to use a unique file name prior to 
pressing ‘Ok’. 

FILE PATH FIELD 

When the .CSV file is the selected output format, the file path defines the location of the saved electronic file. This field 
can be edited to save electronic copies of the selected elements to a specified location prior to pressing ‘Ok’. 

NAME 

Displays the assigned Security item name as shown in the Project Folder. 
Project Folder > Networks > network directory. 

PASSWORD 

This column stores the password, displayed as ‘xxxxxxxx’, associated with each User needing access to a Security 
database. 
The password must first be changed at this location before the User can access a Security database (see change the 
Password field), but can be changed at any time with confirmation by 2 authorised Users. 

It is recommended that passwords contain at least 1 printable non-alpha character. 

This field can only be configured within the selected Regulatory value constraints determined in the User Global tab. 

PC LIST 

This field displays the computer name, code and State of computers selected to access the master database. The 'State' 
field can be 'Add' - awaiting confirmation, 'Delete' - awaiting confirmation or 'Existing' - confirmation received. 

PASSWORD EXPIRY 

This field is edited to increase or decrease the minimum number of days until a password expires and requires changing 
(see change the Password expiry time field). When the password has expired the User is Locked out of the Security 
database. 

Note 
An account that has been locked out due exceeding the password expiry period can be re-enabled by changing the Password (see change 

the Password field), and setting this field to a revised password expiry period (see change the Password expiry time field). 

This field can only be configured within the selected Regulatory value constraints. 
This is a 21 CFR part 11 compliant feature. 

REGULATION 

This function allows the selection of a Regulation. Each Regulation determines the levels of restriction set on the ranges 
for each of the parameter values within the Utility. 

These Regulations are imposed on Security Manager Utility, Series 5000 recorders, computers, and T800/ Eycon™10/20 
Visual Supervisors when the database is deployed. 

It is recommended that this option is defined as early as possible, as any parameter value existing before a Regulation is 
selected will NOT be effected. However any subsequent configuration will be restricted by the Regulation constraints. 
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TYPE 

Displays the Security item type, i.e. EurothermSuite PC, Review and QuickChart Software, 5000 and 6000 Series 
recorders or Visual Supervisor instruments. 

RECIPE 

A recipe can be; 

 ingredients (elements needed for production) or 

 machine setup parameters or 

 steps in batch processing. 

REASON 

This is a Read Only column automatically describing the cause which resulted in the User to be Locked out. 
If there is a number of reasons ONLY one is displayed at a time but each MUST be dealt with before the User can access 
the Security database. 
A User can be Locked out if, the 

 User account has been disabled (‘Enabled’ field reads ‘False’, Reason field reads ‘Account disabled’). 

 login attempts have been exceeded, 

 password has expired, 

 User account has been Retired (‘Retired’ field reads ‘True’ Reason field reads ‘Account retired’). 

USER ID 

This column lists the configured Security Manager User accounts. Current disqualified (Locked out, Disabled, or Retired) 
Users are greyed out. 
This is a Read Only column but is incremented when Users are added. 

USER ID COLUMN 

List’s ALL User Id’s (accounts). 

SYSTEM 

This field is edited to identify an account used to perform system functions. 

Note 
An ‘ESDataSrv’ system account can be created when adding a computer Security item. 

If the field indicates True the system User account can only initiate system functions. After initiating operations are 
performed by the system. False identifies the it as a User account (see change the System field). 

Note 
Users cannot Login using these parameters. 

REMOTE USER ID 

This column lists the configured remote User accounts which require access to the Security database via a 5000 Series 
instrument. 
Each field is edited to allow the creation of a Remote User Id (see change the Remote User Id field) that can access the 
Security database via a 5000 Series instrument. 

REMOTE PASSWORD 

This column stores the Remote password, displayed as ‘xxxxxxxx’, associated with each User requiring access to a 
Security database via a 5000 Series instrument. 
The Remote password must first be changed at this location before the User can access a Security database via a 5000 
Series instrument (see change the Password field), but can be changed at any time. 

It is recommended that passwords contain at least 1 printable non-alpha character. 

This field can only be configured within the selected Regulatory value constraints determined in the User Global tab. 
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RETIRED 

This field is used to terminate the selected User account, thus preventing the selected User access to the Security 
database. 
True indicates the User account has been terminated. False (default) indicates a current active User account (see change 
the Retired field). 

Note 

21 CFR Part 11 Regulations state that Retired User Ids MUST be retained. Although systems configured to the Default 
Regulations will be able remove all Retired User account parameters if the Keep Retired User Ids (User Global tab) reads 
False. 
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e-mail: info.uk@eurotherm.com
Website: http://www.eurotherm.co.uk

HA028131/5  (CN25539)

FINLAND Abo
Eurotherm Finland
Telephone (+358) 2250 6030
Fax (+358) 2250 3201
E-mail info.fi@eurotherm.com

FRANCE Lyon
Eurotherm Automation SA
Telephone (+33 478) 664500
Fax (+33 478) 352490
E-mail info.fr@eurotherm.com

GERMANY Limburg
Eurotherm Deutschland GmbH
Telephone (+49 6431) 2980
Fax (+49 6431) 298119
E-mail info.de@eurotherm.com

HONG KONG
Eurotherm Hongkong
Telephone (+85 2) 2873 3826
Fax (+85 2) 2870 0148
E-mail info.hk@eurotherm.com

INDIA Chennai
Eurotherm India Limited
Telephone (+91 44) 2496 1129
Fax (+91 44) 2496 1831
E-mail info.in@eurotherm.com

IRELAND Dublin
Eurotherm Ireland Limited
Telephone (+353 1) 469 1800
Fax (+353 1) 469 1300
E-mail info.ie@eurotherm.com

ITALY Como
Eurotherm S.r.l
Telephone (+39 031) 975111
Fax (+39 031) 977512
E-mail info.it@eurotherm.com

KOREA Seoul
Eurotherm Korea Limited
Telephone (+82 31) 2738507
Fax (+82 31) 2738508
E-mail info.kr@eurotherm.com

NETHERLANDS Alphen a/d Rijn
Eurotherm B.V.
Telephone (+31 172) 411752
Fax (+31 172) 417260
E-mail info.nl@eurotherm.com

NORWAY Oslo
Eurotherm A/S
Telephone (+47 67) 592170
Fax (+47 67) 118301
E-mail info.no@eurotherm.com

POLAND Katowice
Invensys Eurotherm Sp z o.o
Telephone (+48 32) 218 5100
Fax (+48 32) 218 5108
E-mail info.pl@eurotherm.com

SPAIN Madrid
Eurotherm España SA
Telephone (+34 91) 661 6001
Fax (+34 91) 661 9093
E-mail info.es@eurotherm.com

SWEDEN Malmo
Eurotherm AB
Telephone (+46 40) 384500
Fax (+46 40) 384545
E-mail info.se@eurotherm.com

SWITZERLAND Wollerau
Eurotherm Produkte (Schweiz) AG
Telephone (+41 44) 787 1040
Fax (+41 44) 787 1044
E-mail info.ch@eurotherm.com

UNITED KINGDOM Worthing
Eurotherm Limited
Telephone (+44 1903) 268500
Fax (+44 1903) 265982
E-mail info.uk@eurotherm.com
Web www.eurotherm.co.uk

U.S.A Leesburg VA
Eurotherm Inc.
Telephone (+1 703) 443 0000
Fax (+1 703) 669 1300
E-mail info.us@eurotherm.com
Web www.eurotherm.com
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